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et’s face it: In Mac OS 9, you were king of the
hill, master of your domain. When a problem
arose, you usually knew what went wrong,
how to fix it, and what to do to keep it from
happening again. Mac OS X is a different beast.

For all but the truly geeky among us, OS X is foreign territory, and the spectrum of bugs and problems ranges
from the somewhat familiar to the utterly insane. When something goes wrong in Mac OS X, bumping up
memory allocation ain’t going to fix what's ailing you. Last year, we gave you “50 Biggest Mac Problems (and
How to Squash *Em!).” In this year's AnnualTroubleshooting Superguide, we’re going (almost) exclusively Mac
0S X with 50 all-new bugs we hope you’ll never encounter, But we all know better than that.

THEBIGUH-OHS

Kemel panics, flashing question marks, the scary dead Mac. These
aren't your ordinary problems—these are the problems that make you
reach for your heart pills. But before you decide that the only solution
is a soothing cup of chamomile tea and a good cry, read on—there
might be another answer.

© Dead Mac

PROBLEM: My Mac won’t start up. No lights. No startup sound.
No nothing.

SOLUTION: Before you flip out, take a deep breath. Relax. Your
problem may be a minor one. Or not.

First, check all of your plugs, power outlets, and power strips.
Make sure your keyboard and mouse are plugged in, unplug all other
peripherals (just in case a device is interfering with the startup signal),
and try booting up using the power button on your Mac, not the one
on your keyboard.

If you have a laptop, remove and reinstall the batteries and try
again; ifthat's a no-go, reset the laptop’s Power Manager (check your
user’s guide to find out how—practically every PowerBook does it
differently). For desktop models, particularly Macs that are a few years
old, suspect a bad PRAM battery—replace it (you can get one from an
Apple service center) or have a pro do so. You can also take a stab at
pressing the reset button on your motherboard (usually located next to
the PRAM battery). If all else fails, it’s off to an authorized Mac repair
shop for you.

O Flashing Question Mark
PROBLEM: Alll see when | start up is a folder with a flashing
question-mark icon alternating with a flashing Finder icon.

SOLUTION: A flashing guestion-mark icon means the Mac can’t find a
valid System Folder, Mac OS X or otherwise, from which to boot. You
may have accidentally selected Network Volume rather than the
startup disk in the Mac 0S5 9 SRR

Startup Disk control panel. If

Select the Mac 08 system folder to start up your

that’s the case, chill out—the L eeme
Mac should start up aftera ¥ c Miclntosh HO i
. B Macintosh HO System Feider: L
couple minutes. ] Fcintosh HOSystem: n
If the Mac doesn’t start 5P D

up on its own, the quickest if you inadvertently select Network
solution is to boot off a Mac Disk, you'll have to wait a while
0S 9 CD-ROM (or a recovery CD  pefore your Mac finds a real

from Norton Utilities). To do System Folder.

oting Caveats

that, simply reset the Mac (see Problem 4, “Reset Your Mac,” p18),
insert the CD when you start up, and hold down the C key after hearing
the startup tone. Keep holding it down until you see the “Welcome to
Macintosh” screen. Once you've booted up, launch the Startup Disk
control panel, select a valid system disk, and restart.

If you're still having trouble starting up—especially if you can’t see
the disk on the desktop when you start up using a CD—run Alsoft
DiskWarrior (see “Troubleshooting Toolkit.” p24) to see if it can rebuild
the disk’s directory. If that doesn’t work, move on to Norton Utilities or
TechTool Pro for disk doctoring and/or file recovery. Hopefully one of
those tools will bring your System folder back from the dead. (You do
have a good backup, right?)

© Broken Startup Folder
PROBLEM: After | hear the
startup tone, I see a broken-folder
icon flashing.
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SOLUTION: A broken-folder icon ;Q“ Q &
probably stems from a corrupt & 3‘ ;

or missing Mac OS X system
component. It’s possible that
someone moved or messed up the
Mach kemel files, which are usually

Mac OS 9 shows you the

invisible in Mac 05 X but showup ~ Invisible—and essentiai—Mach
when you're running Mac 0S 9. files, which might be tempting
Trash fodder for the uninitiated.

The official (Apple-blessed)
solution is to back up important files, reformat the disk, reinstall
0S X from the CD, and finally initiate Software Update for a round of
updates. (Didn’t we read

that exact procedure ina
Windows handbook T
somewhere?) reiegmriee Mt S A -

The intrepid, however, 5 Commese
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(particularly the Mach 2 )
files, but look for any Trashing your Extensions.mkext file may
evidence of System folder

repair that broken startup folder that's

tampering). You could try  pyaguing you. Or maybe not.

copying missing files from

a system running the same OS X version, then restarting. Back up
important files first. If you have a CD with exactly the same Mac OS X
version as the one you're running, you can run the 0S X Installer again
to replace the files. I
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If no system files are actually missing, delete the Extensions.mkext
file from the Library folder in the System folder via Mac 0S 9, then
restart (don’t worry, the file automatically regenerates). That procedure
clears the extension cache, which is designed ta sharten startup time
but can sometimes get corrupted and cause trouble.

O Reset Your Mac

PROBLEM: Help! My Mac has crashed, and I can’t access the Restart
or Shut Down commands.

SOLUTION: Sure, sure, sure—Mac OS X never freezes. Riiiight.

Ifyou can’t force-quit the frozen application (Command-Option-
Escape), you'll have to reset your Mac. For a soft reset, press Control-
Command and the power key, if your Mac has one on the keyboard or
ifyou have a laptop. On newer Apple USB Pro keyboards, press
Control-Command-Eject to restart or Control-Command-Option-Eject to
shut down. (Those commands actually attempt to save files before
shutting down.)

For a hard reset, hold down the Power button on your Mac’s front
or side; on some early iMac and Power Mac models, you'll need to
press the special reset button, sometimes using a straightened paper
clip. A hard reset tosses unsaved documents,

Here’s another alternative if you're a geek: If you happen to have
another Mac on the same network and the frozen Mac has Allow
Remote Login turned on, you can log on to the frozen Mac using
Terminal. (Type man ssh at the command line to learn how.) Then
you can use the shutdown command sudo shutdown -h nowto
shut down, orthe top and kill commands (see the sidebar “10
Terminal Tricks,” p28) to quit the prablem app and keep computing.

© Unfinished Startup

PROBLEM:'Mac 0S X gets stuck and refuses to start up completely.

SOLUTION: If Mac OS X halts the startup before it gets to the Mac 0S
X screen, and all you get is a blue screen, gray screen, or spinning ball,
your system may be having a problem with external peripherals.
Unplug them all and try starting up again. If that does the job, plug
them in one at a time, restarting each time, to single out the culprit.
If a blue screen or the Mac OS X screen with a spinning cursor puts
the kibosh on your startup, suspect a bad startup item (often a special
utility of some sort). Restart in Mac 0S-9 (or via a Mac OS 9 CD-ROM),
navigate to the main Library folder and drag any third-party items out

~of the Startupltems folder to your desktop. Restart in Mac 0S X—if your

Mac gets through log-in, add items back to your Startupltems folder
one at a fime, restarting and testing each time you do.

You can also get a blue screen and spinner if you've set up your
Mac to access an Ethernet-based Internet connection, but the domain
name server (DNS) address is invalid or missing, Likewise, other
networking issues can hang startup for a few minutes, so recheck your
network settings. Also, it might help to unplug your Ethernet cable and
see if that enables your Mac to start up.

Finally, Apple notes that you might see a blue screen if you have a
damaged Mac OS 9 font (since Mac OS X reviews fonts in the Mac 0S 9
System Falder at startup). Start up from a Mac QS 9 CD, drag the Fonts
folder from the Mac OS 9 System Folder onto the desktop, and restart
in Mac OS X. If that works, drag the folder back to the System Folder,

itditbid

checking the fonts one at a time for the misfit—or use a font-checking
utility (see Problem 25, “Font Difficulties,” p22).

OErrant Log-in ltems
PROBLEM: My Mac is trying to launch an item at log-in that’s
crashing my machine, E

Login Window |

SOLUTION: Ifyou have a

These Items will open automatically when you log in:

problematic log-in item, 'ﬁffﬁéﬁ TR Kind ;
hold down the Shift key B Ot Sopucaen
immediately after you see 5 3;;:*::; ) x::m

Mac 0S X’s status bar and - e

until the Finder appears.
During this process, if you
see the log-in window,
release the Shift key, log
in, then immediately hold
down the Shift key again.
Disable the item for good
in the Login system preference.

@ Kernel Panics

PROBLEM: I’m getting a kernel panic! Sometimes my Mac
just freezes, other times some 1970s-style, DOS-looking text
appears onscreen.
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quick message from
the colonel: The kemel
is the low-level core

of Mac OS X that
communicates directly
with your hardware, Running Disk First Aid might root out the

and a kernel extension ~ cause of your kernel panic.

is driver software that lets the kernel talk to a third-party device. Kemel
panics often result from an errant kernel extension. Other times,

corrupt files, conflicts, or general errors cause kernel panics.

To deal with a kemnel panic, restart your Mac. Hold down Shift after
hearing the startup tone—that launches Mac 0S X without kernel
extensions. See if you can reproduce the same error that led to the
kernel panic. If you can’t reproduce the error, then the problem
probably lies with the most recent driver you installed; run its
uninstaller or contact the manufacturer.

If you can reproduce the error with kernel extensions off, it might
be a problem with the application or device you were using when the
error occurred—possibly a bug or a known issue. Check Apple’s (orthe
application author’s or device manufacturer's) support site for hints.

Occasionally the problem is file corruption; run £sck (see “10
Terminal Tricks,” p28), Disk First Aid (part of Apple’s Disk Utility), ora
third-party disk doctor.

© Disobedient OS X CD

PROBLEM: | can’t start up from the Mac 0S X CD-ROM.
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SOLUTION: Try booting up from a third-party startup-utility CD, like
Norton Utilities or TechTool Pro. If this works and the OS X disc isn’t




damaged, Apple recommends checking for a firmware update for your
Mac model (www.info.apple.com/support/downloads.html). If your
firmware is up to date, then suspect a problem with a non-Apple
expansion card, a peripheral, or a RAM module that isn’t Apple
certified and/or that did not ship with the Mac originally. Pull any
or all of those out and try starting up from the CD again.

Ifyou can't boot from any CD-ROM, you may have an Open Firmware
password set. See Problem 50, “Easy Break-In,” p29, for details.

O Reinstallation Woes
PROBLEM: Nothing’s working. Is my only choice to chuck Mac 0S X
and start over again? And do | have to reformat my disk to do this?

SOLUTION: If your machine’s completely hosed, you probably need
to reinstall Mac OS X. Under some circumstances, simply running the
Mac OS X Installer application fixes problems and replaces corrupted
or missing files, sometimes bringing a Mac back to life.

But there's a caveat—if you've installed Mac OS X updates that
are newer than the Mac OS version on your installation CD, do nof ruri
the CD-based installer {for instance, don’t run the 10.1 installer if you
have Mac 0S X 10.1.4 installed). If your CD doesn’t match your current
installation, Apple recommends that you back up important files,
delete the existing installation, reformat the disk (which, don’t forget,
erases the entire disk), and reinstall the whole enchilada from the
CD-ROM (start by installing the Mac OS 9 installer if you want to run
Classic). Once you're up and running, use Software Update to instali
updates. No problem, eh? As long as you've been backing up...

SYSTEM
SHORTCOMINGS

Mac OS X is all about performance, right? Yeah, right. Oftentimes, it
seems as if Mac OS X is here to slow you down, not speed you up.
Fortunately, you can fight back—a little.

@ Application Crawl

PROBLEM: As the day goes on, | notice that it takes longer to switch
between applications or to access application commands.
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SOLUTION: Because of the
improved, dynamic way Mac 05
X handles memory, you don't get
out-of-memory messages as 5 tnagaticacn, il
often as you did with Mac 0S v. B e
That’s a mixed blessing, though,
because Mac OS X can slow to

a crawl under the burden of
running applications before it
pops up an alert.
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71 Animate opening applications

The first step when things
slow down is to close some
applications. You'll also notice

Turn off animation and you'll be at
your destination a touch sooner.

slowdowns if the Dock animates icons while launching apps, but
you can turn off this feature in the Dock preferences pane. Also,
tuning off Web Sharing and File Sharing frees up some RAM for
better performance.

The best long-term solution is to install more RAM: It’s also a good
idea to restart individual applications every now and then, particularly
e-mail, Web browsers, word processors, and programs that tend to
stay open and process a lot of different documents. An app’s memory
can leak and fragment, causing it to slow down.

® Spinning Beach-Ball Bingo
PROBLEM: You know what? I'm really The nefariots beach
sick of watching that spinning beach ball. . ball spins again.
SOLUTION: The beach ball generally signifies that a computational
task is taking up processor time. Usually, the beach ball is more
prominent in Carbon applications, which do not take advantage of
multithreading to the extent that Cocoa apps do. Remember that you
can often switch to other applications (via Command-Tab or the Dock}
while one app is stuck “thinking,” then return to your original app.
When beach-ball encounters become chronic, restart the offending
application; it may have confronted its own memory fragmentation.
Likewise, a corrupt document could be causing the problem, so test
different documents. if the problem persists, look for an update to that
application and/or an update to the Mac OS itself. Consider upgrading

a Carbon or Classic application to a Cocoa application or one with a
better reputation for stability.

® Burn, Interrupted
PROBLEM: I'm getting disk-space errors when burning a CD. Plus,
I've noticed that | lose a lot of disk space from bad burns.

SOLUTION: if you receive an error message when burning a disc
{usually Error -36), you may have run out of disk space while burning.
Try deleting some files from your hard disk to make additional room
for temporary files, then burning again. Also, whenever a CD bum
session gets interrupted, run Disk First Aid (part of Apple’s Disk Utility
application) to recover some disk space that burning routines may
take up temporarily.

® Disappearing Disk Space

PROBLEM: Disk space on my Mac seems to dwindle rapidly. The
amount of disappearing space easily outpaces how many apps and
files I'm installing and
storing on my drive.
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system messages),
particularly if you've
turned on Web file sharing or another networking server. This can also
happen if you turn your Mac off every evening instead of letting it run

all night. That’s because the Unix subsystems of Mac 05 X typically

run system maintenance tasks between 3 a.m. and 5 a.m. Ifthese ]

Check your log folders for bloated logs.



» maintenance tasks never run, log files sometimes grow extremely
large.

First, check your log folders. From the Go menu, choose Go To
Folder and type the following folder paths to these invisible files:
/private/var/log/ and /private/var/log/httpd/. Look
for abnormally large files. If you find any, use the program Mac)anitor
(free, http://personalpages.tds.net/~brian_hill/macjanitor.html; on
the Disc) to clean up your log files and run the kind of maintenance
tasks that usually get done in the middle of the night.

Other potential munchers of hard drive space are the cache files for

your Web browser (stored in your personal preferences folder). You can

generally delete these safely. To take a gander at which files are eating
up hard drive space, use OmniDiskSweeper ($15, www.omnigroup.com
fapplications/omnidisksweeper; on the Disc), which will show you the
biggest files on your disks and tell you which files your system uses so
you don’t delete them.
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Lost cump(s) done (Dump '>' file systems):

The freeware MacdJanitor runs maintenance tasks for those of you
who shut down your computers every evening.

® Fuzzy Fonts

PROBLEM: The fonts on my display look fuzzy.

SOLUTION: Your problem is most likely the result of font smoothing.
We know that sounds weird, but smoothing works by purposefully
making the edges of letters a bit fuzzy. Smoothing of certain point sizes
on certain screens may not look right to some people.

Mac OS X allows you to change the smallest font for smoothing in
the General system preferences pane. However, the limit is 12 points,

and Mac 0S X continues

to smooth all fonts that A0 a

are larger than 12. B Dpiwe lund Memrk 3aoep Dis

You can get around Appearance: ::a“--'m”;__‘ij
this hitch by installing g oo (GG =

TinkerTool 2 (free, P ——r—"
www.bresink.de/osx
/TinkerTool2.html; on
the Disc), which gives
you much greater control
over font smoothing.
See “Troubleshooting

Toolkit,” p24, for more

Place seroll arrows: ) At top and botiom
1 Together
ik i e scroll bar to: 8 Jump to next page
© Seroll to here

Number of recent items. | § Applicanoni
3 W oea ¢
B Tl
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on this utility. Change the font-smoothing setting in the

General system preferences pane.

PRIVILEGE
PROBLEMS

Two fundamental issues are completely new and different in Mac OS X:
Unix-style privileges and the reliance on multiple user accounts. As a
result, new and different troubleshooting issues abound...and abound.

® Forgotten Passwords
PROBLEM: I, uh, | mean my friend forgot his password.

SOLUTION: You, uh, [ identity
we mean your friend is
not alone. If you know

the password for an

pas ” —_————
Mt be at least 4 characters

€uooool|
administrative account, log Verify: {“m.’.. 'I D
on to Mac OS Xusing that  bassword Hinc
foptional)

account and open the
Users preferences pane.
Now reassign your friend’s
password. If the problem
is the root or your Admin
account, boot up using the
Mac OS X CD. From the Installer menu, choose Reset Password.

® Obstinate Files

PROBLEM: I'm trying to move a file, but | get an error message
saying that | don’t have the privileges.

Your hint Shouid not easily reved your
pasword 1o others,

) Allgw user 10 ad this ¢

Change passwords in the Users
preferences pane.

SOLUTION: In Mac OS X, privileges (and ownership) are everything.
Ifyou can’t delete or move a file, even with an Admin account, that
means the file has a different owner. This happens a lot with files
other users create in the Shared folder or elsewhere on your disk.
The solution is to either log on as the file’s owner and move the file,
or ask the file’s owner to log on and move or delete it.

If those are not options, you can use the Terminal application to
remove files (using the rm command) or change file privileges (using
chmod), but the most user-friendly way to exorcise these files is to
boot into Mac 0S 9, which doesn’t observe ownership issues and will
let you move or delete files at your whim.

® Trash Trouble

PROBLEM: | can’t even empty my own Trash. What gives?

SOLUTION: Ifyou can’t delete a file that’s in the Trash, it’s probably
locked. To delete this file (after you make sure you want to delete it),
hold down Shift-Option while selecting Empty Trash. Apple also notes
that you may run into problems with trying to delete too many aliases
atonce; if you have a number of aliases in the Trash, drag them out
and trash a few at a time.

If you don’t have privileges for the files you want to dump, you can
delete them from the command line by entering sudo rm -rf
~/.Trash/.




® Mysterious Changing Privileges
PROBLEM: After | use the Package Installer to install something,
privileges for my Applications folder and other items change,
sometimes making it impossible to use certain applications or files.

SOLUTION: A bug in the Package Installer (Mac OS X's installer
application) makes it possible for packages to accidentally change
the permissions of important files and folders on your system.

Unfortunately, the only
easy solution, if you can call
it that, is to run an updated
version of the installation
package for the app, driver,
or update you were trying tc
install (if one is available).
Otherwise, you can change
the permissions back

You need an Administrator password 10
install the software.
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manually by using chown:
and chmod in the command
line {(see “10 Terminal Tricks,”
p28). If your problem is that
privileges for the Applications folder changed after you installed Mac
0S 10.1, Apple has a utility application that can fix the problem
{http://docs.info.apple.com/article.htmi?artnum=106609).

{® Disk Access Denied

The Package Installer has been
known to mangle privileges it's not
supposed to be playing with.

PROBLEM: 'm having major (@80 uovdedinfo ]
problems accessing a secondary @ —
hard disk. tivgas i
Ownver.  cathyby
SOLUTION: According to Apple, a Grome: o

secondary disk can become unusabie
if you format your startup disk and

reinstall Mac OS X. Even though you
Apply to all enclosed folders
create the same user-account name
(T Aeoly

in the Setup Assistant, the installer _ )

N . .. # ignore privileges on this volume
doesn’t necessarily reassign privileges E
on the secondary disk to your new user = Choose to ignore privileges
account, so you end up unable to if you're having trouble
access files on that disk. accessing your own

The solution is to select the disk, stupid disk.
choose File » Show Info in the Finder, select Privileges from the menu,
activate the Ignore Privileges On This Volume option, then restart your
Mac. Select the disk again after you log in, and set privileges the way
you want them using Show Info.

Here’s a similar problem: You can access the secondary disk, but
it won't save information about file privileges. For instance, you create
a file on a FireWire drive and assign limited privileges, but that file
remains accessible to everyone. That’s because Mac OS X treats
external drives as if they were removable, ignoring privileges and
ownership. To change that; select the disk and disable the Ignore
Privileges option via the Show Info dialog box. Now you can set
privileges that Mac OS X will heed—but remember that you may
have problems accessing these files if you connect the drive to a
different Mac.

@ Deleting a Deleted User

PROBLEM: I've deleted

'Y Y] -] HO
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Even though we excommunicated mookie
from our machine, the Finder won't let us
trash his folder.

SOLUTION: This,
my friend, is a job
for Terminal! > B

Say that person’s
user name was mookie.
Although you've deleted
mookie, his home folder,
now named mookie
Deleted, remains. To get rid of that extra baggage, make sure you're
logged into an Admin account, open Terminal, type sudo rm -R
/Users/ 'mookie Deleted’, and press Return. Then enteryour
Admin password and press Return again. Magically, Mac 0S X will
delete mookie’s folder and its contents.

WHENCLASSIC
GOESBAD

So you miss Mac 0S 97 Luckily for you, the Classic environment iets you
reminisce about the simpler days of Mac OS 9 troubleshooting.

& SuperUser Complaints

PROBLEM: I'm encountering an error message telling me that i am
running Classic without SuperUser (root) privileges.
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SOLUTION: ifyousee |« W & @ @

this message in Mac T e R S

0S 10.0.x, it means
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contains your Classic
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Ignore Privileges
option turned on.
Tum it off (see
Problem 19, “Disk
Access Denied,” leftj.
in version 10.1.x, o
the fix, which comes
straight from Apple, is

slightly odd. In System
Preferences, open the To fix your Classic SuperUser problem,

Startup Disk pane and select your Mac OS 9 volume (top) and then
select avalid Mac0S 9 Start up Classic (above).

volume, then choose the Classic pane and click Start. Return to the
Startup Disk pane and select your Mac OS X volume again. Classic
should work correctly for the foreseeable future.
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- @ Classic Crashes

PROBLEM: Classic crashes or freezes as it’s starting up. It gives me
a bus error message or a blank white dialog box that I can’t move, or
it simply won’t finish launching.

SOLUTION: What you've encountered is a standard Mac 0S 9 startup
problem, only here it appears in the Classic environment.

The best plan is to restart in Mac 0S 9, then troubleshoot for an
extension conflict (remember those?) or a driver problem (that's often
what the bus error message indicates). When you start up in Mac 0S
9, check to see if a dialog box requiring a response appears at the very
end of the startup process (this may happen, for instance, if you've

-saved an AppleShare server alias in Mac 0S 9's Startup ltems folder).

Ifyou can’t figure out the exact source of your problem, have Mac 0S

- 9 launch fewer extensions or startup items; hopefully that will eliminate
the offender. Once you fix Mac OS 9, switch back to Mac OS X and cross
your fingers that Classic will start up without trouble.

@ No Copy, No Paste
PROBLEM: I should be able to copy and paste between a Classic
application and a Carbon or Cocoa application, but it's not working.

SOLUTION: Apple says this bug generally pops up when you choose
to have Classic start up at log-in. Open the Classic preferences pane
and turn off the Start Up Classic On Login To This Computer option.
Also, note that copying and pasting between Classic and native
applications can cause some slowdowns and beach-ball spinning

as the system synchronizes the clipboard between the two
environments. Shutting down and restarting Classic will sometimes
improve copy-and-paste performance—that is, if you want to deal
with the headache of shutting down and restarting Classic.

@ Classic Freezes
PROBLEM: All of my running Classic applications appear to be frozen.

SOLUTION: Unlike native Mac OS X applications, Classic applications
can affect (freeze) one another, since they still do cooperative

multitasking and share

Q=0 Force Quit Applications

a memory space & la
Mac 0S 9.

The first step is to
make sure you don’t have
an unattended dialog box
in one of your Classic
applications. Wait to see

If an application doesn't respond for a while,
select its name and click Force Quit.

-

!

& Graphing Calculator
£ intemet Explorer
if the freeze clears up (in © Microsoft Entourage .

L Microsoft Word

the meantime you can

work in Carbon or Cocoa You can opan this window by prassing

Command +Option + Escape.

applications). If it
doesn’t, switch to the
Finder, press Command-Option-Escape, and then force-quit the
offending Classic application. If that frees up the other Classic apps,
save changes in them and quit all of your Classic apps. Otherwise,
force-quit Classic, if it's listed, and start over again.

If your Classic problems are chronic, try starting up in Mac 0S 9
and troubleshooting for extension conflicts and corrupt preferences or

Force-quit Classic to get out of a jam.

other corrupt documents. Ultimately, you’ll want to upgrade to native
Carbon or Cocoa applications and leave Classic behind forever. Your
life will be the better for it.

NEPTAPPS

As much as Apple may try to downplay them, application freezes,
crashes, and conflicts aren’t completely gone in Mac OS X—although
they do have a decidedly different flavor. Here’s how to deal with
these troublemakers.

@ Font Difficulties

PROBLEM: My application

crashes as it’s starting up or I @ “;: ) o
whenever | try to change fonts. o ""E":‘.‘.".';"m"'"" i

. e ™™ 1 ) onteen 4 e
SOLUTION: Your problem may S e
be a corrupt font, which can cause s . ‘Eg?f_ " :%:-E'i-
all kinds of problems in Microsoft | . =~ Greeree - e
Word, Adobe lllustrator, and [ fE""“‘" fam
other apps that check for fonts [ - foera § —
as they launch. L s o

To fix wayward fonts, start by
removing third-party fonts from
the Fonts folder in your Library
folder (or the Fonts folder in your home folder's Library folder), then
restarting and testing the app. If it still crashes, remove nonessential
fonts from that same Fonts folder, as well as from the Fonts folder
inside your Mac 0S 9 System Folder (which Mac OS X also uses).

You can use a utility like DiamondSoft's Font Reserve ($89.95
electronic version, www.fontreserve.com; demo on the Disc) or
MorrisonSoftDesign’s FontDoctor X ($69.99, http://morrisonsoftdesign
.com; demo on the Disc) to track down corruption. If your problem is
with Office, download the latest versions of Microsoft’s fonts from
www.microsoft.com/typography/free.htm.

@ Troubled Preferences
PROBLEM: An application freezes when it's starting up or when |

The Fonts folder may hold the
source of your application’s woes.

change its preferences. [@88 ______  prewws
@nsm W 4 w9 A
Bach Viaw Compurer  More Faegeie  Agplaationt
SOLUTION: Problems | & s | Joonay E Frapnibioimpons
thataren’t fontrelated | . Goee ::"m”“::;‘:.:::
i Moty S L - I com usboverdrve moute prehy
may stem from a e 3 FortCoectmn i taphorer
=L 8 Faniy = I sogeraingow. pst
corrupt preferences [an B B - bivisstitudlild [Fr vl
file. Quit the e B [P -
P A raterances © 4 e 5.0 nataller S hen.
application, open e i I s v

your personal Library
folder, then open the
Preferences folder and
move that application’s preferences file to your desktop. Now restart
the application—if everything runs smoothly, trash the preferences Fle
and reset your preferences within the application.

If that doesn’t work, the genesis of your problem could be file
corruption. See if you can re-create the problem with a different

Preferences reside in your personal Library
folder. Look there for possible corruption.

T R e e S T P I T E T



document. If you can’t, the problem lies in the original document.
Otherwise, run Disk First Aid or a third-party disk doctor. If the problem
doesn’t appear to be a corrupt file, consult the application’s author to
see if your problem is a known issue—or it's always possible that you
have uncovered a new bug.

@ Errant Microsoft Menus

PROBLEM: My menus in Microsoft Word are exhibiting some very
bizarre behavior—commands alter or disappear, and keyboard
shortcuts change.

Qy_w_-hmmmmm—-d

SOLUTION: Sometimes
mutating menu commands
constitute a feature, not a bug.
In Word, the menus and

tcolb:rshcan change depending Word Is supposed to have a
on whetheryou're using a Clear > Formats command in
special document template, \Hére=somewhere. Dumping the

Wh'Ch you can select under. preferences file restores the menu.
Tools » Templates And Add-ins.

If you're not working with an alien template, the problem may be
that you upgraded to Office v. X from Office 2001, bringing forward
some bad preferences from Office 2001°s preferences file. To fix the
glitch, open the Microsoft folder inside your personal Preferences
folder and trash the Word and/or Office settings files; if that doesn’t
work, we've had luck trashing the whole Microsoft folder and letting
Office rebuild all of its preferences. You can also try deleting the
Normal template (in Office’s Templates folder), which stores some
preferences such as customized toolbars and commands.

@ Reinstalling Installer Apps
PROBLEM: | want to reinstall one of the apps that comes with
Mac 0S X. Can | do that without reinstalling Mac 05 X?

SOLUTION: While the Mac OS X installer can reinstall individual apps,
only try it if you're running the same version of the OS as the one on
your installer CD (for more F=®

P s B |

info, see Problem 9, et i e =

5 Dowmmie gty

-
“Reinstallation Woes,” S L g
p19). The easiest solution  [#mm== Haa . ff:'-"
is Pacifist, a utility TN e 2

program from CharlesSoft - rovetrulen

(free, http://homepage ?r'—-;-
.mac.com/csrstka; onthe | *imemma
Disc), which enables you ‘E:.::
to extract an individual b ]

item such as Mail or
TextEdit from Package files
on the Mac OS X CD.

@ Dude, Where’s My App?

PROBLEM: I can’t find an application | just installed. Why are my
apps playing hide-and-seek?

Pacifist allows you to extract individual
files, like Mail, from your Mac OS X CD.

SOLUTION: If you installed the application via an installer (instead
of drag-and-drop), your installer may have placed the program in your

home folder
instead of the & mm
main Applications | **
folder. Check fora
new Applications
folder inside your
home folder,

or look around
and see if the
application’s
installer created
its own folder.

@ Wrong App!
PROBLEM: | can’t get my files to open in the correct application.
880 rewlenenpdiinfe ]

The Opera Web browser likes to stray from
the beaten path sometimes and create an
Applications folder in your home folder.

SOLUTION: That's easy enough to fix. To open %W
, 0y S
a document in the application you want, select e
Raader 3.0 3.0

the document and choose File > Show Info. In
the Info window, select Open With Application
and choose a new application from the pull- | e

down menu. If you'd like all applications with W
this extension to launch in the newly chosen —
application, click Change All. (To blow creator
and owner issues out of the water, check out
SuperGetinfo. See “Troubleshooting Toolkit,”
p24.)

HARDWARE
HEARTACHES

Many of the loudest user complaints about Mac OS X boit down to
hardware and compatibility—or lack of compatibility. Consider yourseif
lucky when a driver for your peripheral is available—even luckier still
when it actually does what it should.

@ USB Printer Perplexmes

PROBLEM: My USB printer works, shall we say, erraticaily.

© # 5 Acrobat Reader 5.0 (3.00 (Oetau

Open docs in the
correct application
by hitting up the
Show Info window.

SOLUTION: The printer subsystem in Mac 0S5 10.1.x leaves
something to be desired, to put it politely.

One problem that plagues many users is that printers stop
working after you launch the Classic environment. In that case, your
options include avoiding Classic or restarting the Mac OS after usmg
a Classic application.

Also, Apple suggests that you not connect a USB printer to a LISB
port on your Mac’s keyboard; use a port connected directly to your -
Mac or a powered hub for best results.

If you’re getting printer errors, such as Error-108, or the Print
Center crashes, Apple recommends deleting the printer driver folders
{you'll find these in the Printers folder in the main Library folder). Start
by trashing the Canon folder, which can be troublesome, and then




ANDHOW

- testingyour printer, (8c@ .. Qe . ©
Dothisevenifyou | © =W “g" 3: v ..ffw
don’thaveaCanon (swmase Bl G
printer (ifyoudo, ~ [Uommem - BT -
you'll need to e raan | i oo 0 ron
download a new H ser 08 T
driver from Canon’s é:u;ww
Web site). Protwwcn X

Ifthat doesn’t T ———

work, delete the
Printers folder
altogether, then
reinstall your third-party printer driver or use the Mac 0S X CD-ROM to
rerun the installer and reinstall the printer drivers. Of course, if you've
updated beyond the OS version on your CD-ROM, you shouldn’t run the
CD-based installer (see Problem 9, “Reinstallation Woes,” p19).
Instead, it's best to download the drivers from the manufacturer's Web
site and install them directly. Sometimes a compatible driverisn’t even
available via a Mac OS CD or Software Update session, so the
manufacturer’s site is usually your best option.

@ AppleTalk Printer Failure

PROBLEM: | can’t connect to an AppleTalk printer.

Your printer driver folders should go on the
chopping block if your printer is error prone.

SOLUTION: Apple notes that AppleTalk printers only work when one—
and only one—network port (like Ethernet) is using AppleTalk at a
time. If you've got an AppleTalk printer connected via Etheret and
your Mac can’t talk to the printer, make sure you don’t have AppleTalk
active for another port, such as AirPort. In that case, open the Network

TROUBLES

If you want to troubleshoot like the pros, check
out the following apps:

9o NortonDiskDoCtor st il

Saec the S 10 CRCE, Ehen click Examing

pane, select AirPort from the Show menu, click the AppleTalk tab, and
make sure AppleTalk’s not already active.

@ Failed Print Jobs

PROBLEM: | keep sending print jobs, but they keep failing. | don’t
even get the courtesy of an error message!

SOLUTION: Make sure you haven’t moved or renamed the Utilities
folder inside the Applications folder. According to Apple, if you have,
applications can’t find the Print Center to complete print jobs.

@ Driver Incompatibilities

PROBLEM: Neither my I o P T Specal Window
scanner nor my joystick Bwd xo |

works with Mac 0S X. 'm e P o |

very annoyed. | Cone o |

SOLUTION: Stand | i x|

in line. With a new T

operating system come mm
driver headaches, s s i o "

understandably. Still,
scanner owners are sick of
seeing messages like “XYZ
Corp is committed to Mac
0S X" and “Drivers are due
any day now.”

Well, keep hanging in there. Microtek , Canon, HP, and others are
currently working on drivers—look for them at VersionTracker

You may be able to use the TWAIN
command to get scans from your
scanner—but this requires some sort
of driver and the device must be
TWAIN compliant.

BACKUP SOFTWARE
The best recovery tool, bar none, is a good
backup. Here are a few to choose from:

DANTZ RETROSPECT EXPRESS ($79) and
RETROSPECT DESKTOP ($249),

EMERGENCY SOFTWARE
Keep these within arm’s reach for when a good
Mac goes bad.

=j untewad

ALSOFT DISKWARRIOR

$69.95, www.alsoft.com

You should run this near-miraculous utility first
thing after a catastrophic disk failure, because
it creates a replacement desktop directory to
recover your data. DiskWarrior runs in OS 9 but
can fix a Mac OS X disk.

— format W D5 Brunded $9Le) W T8

www.dantz.com

a0 Bt $al o ATA b 2 B8

Les

POCKET SOFTWARE POCKETBACKUP
$20, www.pocketsw.com; on the Disc

QDEA SYNCHRONIZE X PLUS ($29.95) and
SYNCHRONIZEPRO X ($99.95),
www.qdea.com; on the Disc

Norton Utilities can save your hide if your
Mac has a meltdown.

FIREWALL SOFTWARE
The Unix underpinnings of Mac 0OS X make
your machine more of a target for hackers,

SYMANTEC NORTON UTILITIES

$99.95, www.symantec.com

The OS X version of Norton Utilities doesn’t

do everything previous versions could (for
example, it's missing disk defragmenting), but
it’s great at fixing disks and finding lost files.

MICROMAT TECHTOOL PRO ANDDRIVE1D
$97.98 and $69.95, www.micromat.com
Use TechTool Pro 3 in Mac OS 9 to fix a disk,
recover files (even on Mac OS X volumes), and
optimize your drive. Drive 10 is a drive-repair
utility that runs within Mac OS X.

so you should consider at least a software
firewall if you spend some time connected.
Here are a few options:

PLIRIS-S50FT FIREWALK X
$34.99, www.pliris-soft.com; on the Disc




(www.versiontracker.com/macosx/drivers). For those of you who use
Epson scanners and Adobe Photoshop 7, there may be a workaround
{check out www.epsondevelopers.com/macscan/photoshoposx_
install.jsp for more info). Plus, there is a little bit of good news in all of
this: At least you

" . 1 T ] ) USH Overdrive X
don’t have to wait on
scanner applications mﬂ R
to movetoMac OSX. | ... - i
Photoshop 7 and vl seungs e P
Lemke Software’s - 5;-?

- | P Bumen -
GraphicConverter 4.4 | e 3 Caps bk
{$30, www.lemkesoft !::::ml;:n-

.com) both offer a e - et el

; Woost (Wi tute ) etrees- o e d
TWAIN Acquire o T
command that even Accuiacancn: [Spem T

works with some
beta drivers. Or you
can opt for Hamrick
Software’s VueScar
($40, www.hamrick.com/vsm.html}, shareware that enabies scanning
for unsupported models, even without drivers in some cases.

As for input devices, especially some game controllers, you may
never get drivers from the company, but you might get help from
Alessandro Levi Montalcini, author of USB Overdrive ($20, www
.usboverdrive.com). Using this substitute driver (the Mac 0S X
version is in beta as of press time; on the Disc), you can redeem
quite a bit of functionality (including control over features like
mouse speed and programmable buttons) for your mice, joysticks,
gamepads, and other input devices,

Just when you felt abandoned by your input
devices’ manufacturers, USB Overdrive lets
you regain some control.

$59.95, www.intego.com; on the Disc

upon us. The utility adds menus so you can
quickly navigate to favorite folders, recent

& Double Trouble

PROBLEM: Using two monitors is causing major problems, especiaily
when | run Classic.

SOLUTION: Mac 0S X may thiow a wrench in the works for those of
you who use dual monitors. For instance, Apple notes that in the
Classic environment, OpenGL acceleration only works properly when
you use one monitor. As a result, Classic games may slow to a crawl
if you have dual monitors. The fix? Put your Mac to sleep and remove
the second monitor before playing a game in Classic.

Some users have also reported trouble with dual monitors that
use video cards from different manufacturers. For instance, conflicts
between ATl and GeForce drivers (sometimes resulting in kemel panics)
are known issues, but they may not be resolved by the time you read
this. In rare cases, you can fix the problem by moving the ATl cardto a
different PCl slot; otherwise, you may need to replace one of the cards.

If the problem is that your Mac simply doesn't recognize your
video cards (this happens more often in older Macs), you should
again experiment with using different slots for your PCl-based
video cards. You'll probably have the most luck with cards from the
same manufacturer.

@ Blank Display

PROBLEM: In the Displays preferences pane, | unchecked the Show
Modes Recommended By Display box. Then | tried to select a
nonrecommended resolution and the screen went blank. Help!

SOLUTION: Ifyou can, restart via a Mac 05 9 CD-ROM. Even without

a display, you should be able to restart via the keyboard. Press the

status of currently running apps, and open
Terminal to dig into the Darwin command line.

folders, default volumes, and even folders

$25, http://personalpages.tds.net
/~brian_hill/brickhouse.html; on the Disc

currently open in Finder windows.

$69.95, www.symantec.com

$20, www.barebones.com; on the Disc
From the BBEdit folks comes Super Get Info,
a tool that extends the powers of Mac OS X’s

POWER TOOLS
Bend OS X to your will with one of these
power-user favorites.

Free, www.bresink.de/osx
[TinkerTool2.html

With the aid of this ultimate user-interface tool
for Mac OS X, you can enable and disable a
variety of features, such as hidden files in the
Finder; place the Trash on the desktop; and
add a Quit item to the Finder menu.

$34.95, www.stclairsoft.com; on the Disc
Default Folder X mends the open and save
dialog box travesty that Apple has foisted

Mac OS X's Unix roots make virus checking
even more important than in the past.

Included with Mac OS X

Buried within Disk Copy is not only the ability
to mount disk images, but also to create them,
encrypt them, and burn them to CD or DVD
media. Sweet!

Included with Mac OS X
Have you become truly intimate with your

Unix-derived utilities? Check out Console for
an easy way to read nearly indecipherable
error logs, use ProcessViewer to explore the

Show Info dialog box by giving you greater
control over Unix-style permissions, as well as
Mac creator and type codes.

Growp. | admin

Owner Group

Read. W W
wite. W ]
Enecule E g

Access Unix-style permissions, play with
creator and type codes—and try not to look
like a geek while your mom lays out your
clothes for tomorrow morning.
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Power key on your

e AN Dl'w:-] Murd  Newort Ramup O

keyboard if it has one, [FORRY Arange | Color |
or Control-Eject if not, R

Resolutions Colors. | Millions E
then press R to restart. cariso T aatos . (TR W
Listen for the startup tone, $00% 800
then quickly insert the R ivelihuptien iy
Mac 0S 9 CD-ROM. e ¥ v ot et

When you see the Mac
0S 9 desktop, open the
Preferences folder inside
the main Library folder and
delete the file named com.apple.windowserver.plist. Restart your Mac
(remove the CD after the startup sound so your Mac starts up in Mac
0S X) to re-create a preferences file with a default monitor setting.

@ Finicky FireWire
PROBLEM: ’'m experiencing some technical difficulties with my
FireWire devices.

If you try to use a nonrecommended
resolution, you may end up staring
down a blank screen.

SOLUTION: FireWire and Mac 0S
X are fairly good partners, but that
doesn’t mean they're not prone to
an occasional domestic spat.

For instance, the Classic
environment won't recognize
FireWire cameras, so make sure
you run the OS X—native version of
iMovie. Plus, if you have an older
FireWire drive, you may want to
use your internal disk for
camcorder-to-disk transfers.

Ifyou're using two FireWire
drives and copying between
them, Apple notes that large copy
operations will sometimes fail. To fix the problem, make sure you're
using the latest Mac OS version, update the firmware on both FireWire
drives (check with your drive’s manufacturer for the latest firmware),
and try copying smaller batches of files at once, if possible.

Finally, make sure you eject any FireWire drive’s volume before
unplugging the disk. (Drag the disk’s icon to the Trash; select it and
choose File » Eject; or Control-click the disk.) If you don’t, you could
lose data and cause Mac OS X errors or crashes.

@ Sound Advice

PROBLEM: My sound skips and sometimes | swear I'm going deaf
because | can’t hear anything.

Help

FireWire
Open
Show info

Duplicate
Make Alias

Copy “FireWire 40GB°

Eject FireWire and USB
external hard disks before
disconnecting them from
your Mac.

SOLUTION: On some late-model Macs (such as the Gigabit Ethermnet
and later PowerBooks, dual USB and later iBooks, flat-panel iMacs,
and QuickSilver G4s), the sound hardware powers down to save
energy; for the first few seconds after your Mac awakens, you'll notice
a sound delay and/or you’ll see the spinning beach ball. According to
Apple, the current solution is to install external USB speakers. How
convenient.

Ifyou don’t hear any sounds when your Mac wakes from sleep,
open the Sound pane and make sure your system volume isn’t on

mute. If itisn’t, put the Mac back to sleep and wake it up again. If that
doesn’t help, restart your Mac.

@ Typing Traumas

PROBLEM: | press a key and a character appears in another
language (or doesn’t appear at all!). | mean, | had a couple of beers,
but | swear I'm not seeing things.

SOLUTION: If words
start appearing in a
language you don’t
understand, you're
probably not drunk.
(Actually, how would
we know?) More likely,
your keyboard is not
set to the same
language as your
system. Look for a
keyboard menu (it has
a nation’s flag as its
icon) on the menu bar.
Open it and choose the
correct keyboard
layout. If you don’t see
a keyboard menu, open
the International
preferences pane, click
the Keyboard Menu
tab, and make sure the
box next to the correct
language (you know,
yours) is checked.

If your number pad
isn’t working correctly,
you may have
inadvertently tumed on
Mouse Keys. Select the
Universal Access
preferences pane and
click the Mouse tab.
Make sure Mouse Keys
is turned off to get the

=40 d

Disptys oung_ Nework_ wp Oise
["Language | Date | Time

Turn on the keyboard layouts and input methods to appear
in the Keyboard Menu, The menu appears when more than
ane s enabled.

[ s@swedsh - fro Roman +
B Flswass Franch Roman -
[ Eswiss Garman Roman

0 Bsymoot Roman

¥ = Roman

O BEeaences Romas (U Unicode

2 Eunicode Hex Input Unicode

@ Eviemamese Unicode

O @ena o

o Doery =B 3 B
2 oasex HERR a
D wWeess rHPR B

I — £ Options )
We want to click U.S. here, not
Swiss German or Vietnamese.

Displays Sound Network Startup Dise

) Use keyboard shortcuts to turn universal access features on or off
‘When using the computer, | have difficulties with:

[ Keyboard YfGH

Hifficulties using the mouse

Mouse Keys: ) On @& Off

Use the numeric keypad in place of the mouse

Pressing Option fve times will turn mowse keys on or off

To control mouse pointer movement;
Initial Delay: =

Turn off Mouse Keys in the Universal
Access pane if it interferes with your
number keypad.

number-pad functionality back.

@ Closed PowerBook

PROBLEM: I'm trying to use my PowerBook G3 with a monitor,
keyboard, and mouse while leaving its lid closed. But when | wake
the computer, it only wakes up for a few seconds before going
back to sleep. Is my PowerBook narcoleptic?

SOLUTION: Well, first you need an external keyboard that includes a
power key (this rules out the latest Apple Pro USB keyboard). Shut
down the PowerBook (don’t just put it to sleep), and plug in the
display, mouse, and keyboard. Press the power button on the
keyboard to start up your PowerBook without turning onits LCD.

il gslistd gt



NOT\WORKING
NETWORKING

Sure, we welcome high-end, superdeluxe networking systems like
Mac OS X—but often they come with their own headaches. Before
you get out the Tylenol, though, check some of the fixes below.

@ G-g-g-ghost Servers
PROBLEM: 1 see more than one instance of the same AppleShare
server in the Connect To Server dialog box.

SOLUTION: You might see more tharn one of the same Appiedhdre
or File Sharing server when your network uses DHCP to assign IP
addresses dynamically. Even though the Macs on your network
constantly appear
at different IP
addresses, your
Connect To Server

Network

Display: Sount  wetwors  Martup D

tocation. Automatic "9
feature keeps
track of older =S __B o
IP addresses. __ [TOIeY seroe | avpleTalk [ proxies | |
Unfortunatety, Configure. ~ Manually i )

this bug has no

obvious solution, w asness (19216818 4221

just workarounds. = v

prciroill IENUEETE
paranormal

clutter {that is, 1w
delete the files
that are keeping
tabs on these
addresses) by
opening the
Terminal and typing sude rm /var/slp.regfile, then pressing
Return. Enter your admin password and press Return again, then
restart your Mac. (Do this for any affected Macs on your network.)

The ghost servers should disappear...for now. (Mwa-ha-ha-ha!)

To avoid the issue altogether, assign manual IP addresses on your
LAN, if possible; if you're using an Internet router, simply select IP
addresses in your local range (for example, 192.168.1.2, 192.168.1.3,
and so on) and assign them to your Macs. Use the router’s IP address
{often the .1 or .254 address of your IP range) as the router address in
your Network pane. Or you can use AppleTalk for file sharing (turn on
AppleTalk in the Network pane, then select the AppleTalk neighborhood
in the Connect To Server window); this is slower but less troublesome.

@ AppleTalk Is Active, Yet Inactive

PROBLEM: | swear on my dog’s life that AppleTalk is turned on, but

EAMMIE Ag2pIc_ con, £ O ives
vernen Acaress D003 958500 TE

if you have an internet router, you may find it
handy to just go ahead and specify static IP
addresses on your LAN.

I'm not seeing AppleTalk servers (or in some cases AppleTalk printers).

SOLUTION: Luckily for your dog, the problem is probably that your
Mac isn’t recognizing the AppleTalk zones on your network. Apple’s

solution is to try turning
AppleTalk off and on again
{don’t forget to click Apply
Now in the Network pane).
if that doesn’t help things,
create a new location
{choose New Location
from the Location menuj
and switch to that location,

then switch back to

| TCP/iP | PPFoE Proxies

¥ Make AppieTalk Active

Computer Name. Cathy Lu's Computer
{Can be changed in Sharing Frefer ence sz

AppieTaik Zone. ~ Macaddict =

it your Mac doesn’'t want to recognize
your AppleTalk zones, try turning
AppleTalk off and then on again. Don't

Automatic. You should now  ask us why, but sometimes that works.
see the AppleTalk Zone
menu spring to life, enabiing you 16 select your local Appielalk zone.

® Modem Keeps on Going...& Going

PROBLEM: My modem keeps trying to dial up, even when I'm not

asking it to.
What can 1 do?

SOLUTION: This
one’s easy. Your
modem is probably
set for automatic
connections. In the

PPP tab of the Network

preferences pane,
click PPP Options
and turn off Connect
Automatically When
Starting TCP/IP
Applications.

Network

Session Options:
T Connect automancaily wihen staring 0P/ IF applscabons
!ﬁmm@ minutes to MAINtain connecHon
# Disconnect if idle for 15 minutes
7 Disconnect when user iogs out
W redial if busy
Redial 1 tewes
Wait 30 seconas velore iedabing
Advanced Options:
W Send PPP echo packeis
 Use TCP header compression
T Connect using a Terminal window commend e
T use verbase logging

Turn off autoconnect to keep your Mac from
experiencing psychodialing phenomena.

@ Wrong Port
PROBLEM: | want to connect via Ethernet or AirPort, but my Mac
insists on dialing out through my poky modem.

SOLUTION: Mac 0S5 X's multihoming feature (the ability to use more

than one TCP/IP
port at once) is
great, but it can be
confusing, too. If
you notice that
your Mac is giving
priority to the
wrong port (say,
your modem over
Ethernet), you can
change which port
your Mac tries first.
Open the Network
pane and choose
Active Network
Ports from the

Active Ports

Check available port configurations in the list below to activate then
All checked g jons are active simult; ly. Drag ports in
list to specify the order to try them when connecting to a network.

g ' Port Configurations
lEI;CL

! Built-in Ethernet

Turn off any port you no ionger want 1c use in this location by unchi

To change the name of a port configuration, double-click it.
To create multiple configurations of a port, use the New or Duplicaty
To delete a port configuration, select it and press Delete.

Drag ports around to change their priority.

Show puli-down mentu. You can set the order of priority by dragging
the items around in the list; the system tries the top port first, followed

by the next, and so on.



ANDH

- @ Flighty IP Address

PROBLEM: | can’t access the network or Internet, and when 1 go into
the Network pane, Mac OS X has changed my IP address.

SOLUTION: There are two possible reasons for this capriciousness.
ifyou have a networking port set to DHCP, but you don’t have a DHCP
server (or the connection to the DHCP server isn’t established because
the server is down), Mac OS X randomly assigns an IP address after a
few moments. To reset the address, connect your Mac to the DHCP
server (for instance, turn on your cable modem or connect to your LANj,
go to the TCP/IP tab of the Network pane, select Manually from the
Configure menu, and click Apply Now. Then change back to Using DHCP
and click Apply Now again.

The other possibility is that you're entering IP addresses with
leading Os—for example, 192.168.001.001. That's a no-no, as your
Mac converts IP addresses into octal (Base 8) numbers, and the
leading 0s mess up that translation. Use 192.168.1.1 instead.

@ Where’s the Web?

PROBLEM: | can access some Internet services, such as my email,
but not Web or FTP sites.

SOLUTION: You need a DNS {domain name server} entry in the
Network pane for the particular Internet port you're using. Without

- __MP‘PPOE_Y AppleTalk Y Proxies |

Configure. ' Using DHCP ) i3
Domain Name Servers iOptionall
iP Address 4.2.2.1

iProwided by DHCP Server;

1192.168.34.76|
Subnet Mask. |

Add a DNS entry if you're having problems accessing the Web.

1}

Although it may intimidate the bejesus out of

access to DNS, your Web browser and other applications can’t
translate named resources (as in apple.com) to numbered IP
addresses. If you have a direct connection toyour ISP, enter the ISP’s
DNS address; if you're using a router that connects to DNS
automatically, you'll often use a special address for the DNS entry
(check your router's manual).

If you have a DNS entry, the DNS computer may be down; contact
your ISP to see whether an alternate DNS address is available.

@ Windows Snubbing

PROBLEM: I'm on one of those annoying multiplatform networks,
and my Mac crashes whenever | try to access a Windows or Windows
NT server volume.

SOLUTION: Although we’d like to think this problem results from an
evil Microsoft plot to rid the world of Macs, it (probably) doesn’t. Two
very common possibilities may explain what's going on.

First, although Mac OS X offers the native ability to log in to servers
using the Windows SMB protocol, you can only log in to one such
server at a time; log in to more than one, and you'll experience
crashes or even kernel panics (at least in versions 10.1 to 10.1.4),
Stick to one server or get a client like Thursby Software’s Dave
($149, www.thursby.com; demo on the Disc), which enables peer-to-
peer Windows-protocol sharing between Macs and PCs. Or grab Mac
05 10.2 once it’s released.

Also, when you’re working with SMB or Samba (and sometimes
AppleShare), crashes can occur when the Windows share point, the
named volume or folder specified for sharing on the Windows
machine, has a space in its name. On the Windows machine or server,
make absolutely sure the share point's name has no spaces—use
underscores instead.

© chmod

Use this command to change file permissions
(like those you would set in the Show Info
dialog box) at the command line. This

you, the Terminal application offers powerful
features and bailouts for many a sticky
situation. Here are 10 commands you might
appreciate knowing when the you-know-what
hits the fan.

@ sudo

This command grants root privileges for a
particular command; for instance, to delete
all items in the current working folder, type

io rm *.

@ cd and pwd

Ifyou aren’t familiar with the Unix command
line, here's your crash course for looking like
you know what you're doing. Use the o«
command to change the current working

the Finder. Type / to move to the root
folder on your Mac, orcd /Libr

lenge to the main Library folder. Type cd

/ ; to change to the documents
folder inside your home folder. Type

to see the current working directory, just in
case you've forgotten. (It also usually appears
in the title bar of the Terminal window.)

©1ls -lorll
Type 1s ~1 or 11 (that's the lowercase letter
l, not the number 1) to see a long listing
of items in the current folder. This is useful
for showing hidden Unix files and the
permissions for files and folders. Typing 11

s would list all files in the
Pictures folder inside your home folder.

ument:

Lot

command takes either numbers (like

flags (like u+3x, which turns on execute
permissions for users) as argumenlr. For
example, chmod 7 .pl
would change the privileges for a h\;polhetical
file called myscript.pl to read, write, and
execute for all users (visit http://acm.unl.edu
/resources/tutorial.php#perm to find out
more about numbers and flags). You'll often
need to use sudo with this command, as well
as cho
line to

n. Type man chmod at the command
N more,

© chown
Employ this command to change the owner
information for a file or folder, For instance,
you might type a line like this

sudo chown




SECURITY
CONUNDRUMS

With all of the viruses and hacking going on around us, computer
security is on everyone’s minds. Because Mac OS X has Unix at its
core, it presents some slight twists on our cozy little bulletproof
Mac OS of the past. For one thing, it's slightly less bulletproof.

@ Keychain Insecurity
PROBLEM: | notice that my Keychain, which stores all of my
passwords, opens automatically when I log in. Um, isn’t that

7
a problem? Change "sjobs” Settings

S Lock after E_k_ ?
ELock when the system sieeps

( Gneel 7 ST

SOLUTION: Um, it can
be, ifyour computer is
in a high-traffic area.
The solution is to set

minutes of inactivily

'{-C’IIW! Passphrase...

stringent self-locking Use Keychain Access to change your
preferences security preferences.

via the Keychain Settings dialog box (in the Edit menu) in the Keychain
Access app. From there, you can choose to lock the Keychain after a
specified amount of time and/or when your Mac goes to sleep. For
even more security, use the same settings box to change your
Keychain’s password to something other than your log-in password.

@® Denied!

PROBLEM: My log-in password doesn’t unlock my Keychain.

SOLUTION: This can happen when an administrator (other than
yourself) changes your log-in password. You'll need to use your

7. This changes the
ownershnp cf a fnle Lalled photo1.jpg to a user
named stevej. In a multiple-user situation,
you can use chgrp to change the group
associated with a file; type man chgxpto
find out more.

typing

“top, ps,and kill
The command-line version of ProcessViewer
is top—type it to see a list of running

damage it.

immediately after your Mac starts up to boot
into single-user mode (see fack,
you need to alter files, mount the hard disk by
. From there, regular
Unix commands will work. Be careful—you're
now in the root account, so you can make any
change to the system and even potentially

>console Log-Ins

previous password, either the original password assigned to your
account or any subsequent passwords you assigned via the Users
pane or Keychain Access application, to open the Keychain. You can
then change the password via the Edit > user name Settings command
in the Keychain Access app.

@ Easy Break-In

PROBLEM: I'm concerned that someone with a Mac OS startup CD
can easily bypass my Mac’s log-in screen.

SOLUTION: That's true. The log-in screen is only as secure as your
Mac’s keyboard and CD drive. You can, however, activate a more
secure password scheme using the Open Firmware Password
application, which works only on the latest rounds of iMacs, iBooks,
PowerMacs, and PowerBooks—basically, any Mac that supports
Open Firmware 4.17 or later. (See http://docs.info.apple.com
[article.html?artnum=106482 for more info.)

First, make sure your firmware is up to date by checking
at www.apple.com/swupdates. Next, download the Open
Firmware Password software (http://docs.info.apple.com/articie
.html?artnum=120095). Install the application and launch it,
following Apple’s instructions closely. When you’re done, your Mac
will no longer be able to start up from a CD-ROM, as a target disk,
or in various other startup modes without the proper password.
Just don’t forget this password, ever, or you may end up, as they
say, screwed. B

'Tnddsml’fet "swﬂmnmnmu'»anﬁwmpumsbwks.indudingmmdng
mmiﬁmminmmm;ue.mmmmmmw 0
.hwmg_opmﬂngsystem‘uacosx?‘butowmiheheatof
Uuuhleshmﬁngmes.ﬂemealshedoesn’tmanﬁ. G

fsck

For major disk errors, you can run Apple’s
ut;lzty Boot into single-user mode, type
3 , and press Return. Mac

OS Xwill check and fix your disk if possible.
Sometimes a single pass doesn’t fix every
problem on the disk; you may need to run

=~k repeatedly.

below). If

ping

processes, and press Command-C to exit the
application. (For a more comprehensive list,
type ps 1%.) Both £op and ps are useful
for finding out the PID (ID number) of, say, an
app that has crashed. Using the PID, you can
then use the k111 command to force-quit
that process (@asin kill 392).

= Single-User Mode
When you're having trouble getting your Mac
to start up or log in, hold down Command-S

In the log-in window, you can directly access
the command line by typing >cone

instead of a user name (choose the Other
icon if you only see user icons in the log-in
window). This is great for bypassing trouble
with log-in items or the Finder; now you're
free to log in and fix a problem—for instance,
deleting an offending preference file (using
the rm file = command) and exiting to the
log-in window (type exit and press Return).

Along with other familiar Net utilities
(nslookup, finger, whois), you can use a
command-line 2 to test a network
connectron quickly. Type something like

: m to test Internet access, or

2 . to test a LAN-based

cormecllon If you get a scrolling list that
shows how many milliseconds it took to
receive the packet, you know the connection
is working. Press Control-C to stop




